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Notice 
Read this manual carefully before any assembling and using. Incorrect handling of products in this manual can 

result in injury and damage to persons and machinery. Strictly adhere to the technical information regarding 

installation requirements. 

This manual is not for use or disclosure outside of Leadshine except under permission. All rights are reserved. 

No part of this manual shall be reproduced, stored in retrieval form, or transmitted by any means, electronic, 

mechanical, photocopying, recording, or otherwise without approval from Leadshine. While every precaution 

has been taken in the preparation of the book, Leadshine assumes no responsibility for errors or omissions. 

Neither is any liability assumed for damages resulting from the use of the information contained herein. 

This document is proprietary information of Leadshine that is furnished for customer use ONLY. Information 

in this document is subject to change without notice and does not represent a commitment on the part of 

Leadshine. Therefore, information contained in this manual may be updated from time-to-time due to product 

improvements, etc., and may not conform in every respect to former issues. 

Record of Revisions 
Revision Date Author Description of Release 

1.0 Oct, 2017 MF Initial Release 

3.1      Oct, 2018 MF, CL Software update to version 3.1 to reflect CS-D firmware upgrade 
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1. Introduction
Thank you for choosing Leadshine products. The CS-D series closed loop stepper drives include 4 models, CS-

D403, CS-D507, CS-D808, and CS-D1008. When those drives are implemented with compatible stepper 

motors with encoders, your motion control system performance will get significant improvement over 

traditional open loop stepper systems such as no loss of step, higher torque, lower noise & heating, and 

smoother motion. Leadshine closed loop products are also ideal alternatives to replace similar frame size 

brushless servo systems in low-to-middle speed applications because of their features of much lower cost, 

much higher torque, and much easier system setup and configuration.

For most applications Leadshine closed loop stepper systems are easy to configure & setup and can be 

implemented without any tuning efforts, same as classic open loop stepper systems. But in some cases this free 

ProTuner software tool can still be used for performance tuning, and configuring custom settings like output 

current, micro-step resolution, control type, etc. 

2. Prerequisites

Leadshine ProTuner for CS-D closed loop stepper drives is a free Windows based software.  To successfully 

run this software, the following prerequisites must be satisfied. 

2.1 Operation System 

This ProTuner software must be installed and run on a computer with Windows 7 or Window 10 operating 

system for either 32 or 64 bit. 

2.2 Motor Connection 

From ProTuner software settings of a CS-D drive can be changed with or without a stepper motor connected. 

• Without a stepper motor connected, a user can only use the ProTuner software to change the CS-D

drive parameter values.

• With a stepper motor connected properly to the CS-D drive, a user can not only configure settings of

the connected drive but also run the motor to test and tune motion performance. Refer to the CS-D

drive user manual for how to connect a stepper motor.

2.3 Accessories 

To connect a CS-D Closed loop stepper drive to the computer, Leadshine offers a special RS232 cable (Figure 

1). It can be used to connect to the RS232 connector on the computer. If such a RS232 connector does not exist 

on that computer, a user can use a USB to RS232 adaptor (Figure 2) or conversion cable to get the drive 
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connected. Please note that not all USB to RS232 adaptors will work. Contact your CS-D drive seller or 

Leadshine technical support for getting such a USB to RS232 adaptor, which have been confirmed to work fine 

with the CS-D series closed loop stepper drives. 

Figure 1: RS232 Tuning cable     Figure 2: USB to RS232 converter 

3. Software Overview

Refer the following sections for a quick overview for this ProTuner software. 

3.2 Work Space 

Figure 3: Sofware workspace 

Toolbar 

Menu bar 



                                CS Series Closed-loop Stepper Drives Software Manual V3.1 

 

Page | 3  
 

3.3 Menu and Toolbar 

Menu items and respective toolbar items are described in the following table. The toolbar is one on the left 

screen (Figure 3) offer the most frequency commands. Menu bar items are described below: 

Menu Submenu Item Toolbar Icon Function 

Project 

Open - Open an existing .lsr configuration file 

Save As - 
Save parameter values to an .lsr configuration 
file 

Exit - Close ProTuner for CS-D software 

Drive 

Communication 

 

Connect/disconnect the drive to/from the 
computer 

Error Track 

 

Track error history of the CS-D drive 

Write to Drive 

 

Download parameter values to the drive 

Reset - Reset the drive back to its factory settings 

Configuration 

Parameters  

 

Read or edit the CS-D drive parameter values 

Motion Test 

 

Motion test for the connected drive and motor; 
or, monitoring motion performance when 
powered by a controller, PLC, pulse 
generator... 

Help 

Software 
Manual 

- Quick link to the software user manual 

Product - The CS-D drive information 
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4. Connect the Drive 

Follow the following steps to connect a CS-D closed loop step drive to the ProTuner software on your 

computer. 

• Read section 2.3 first, then connect the drive to your computer through a RS232 connection.  

• Power on the CS-D closed loop stepper drive. 

• Launch ProTuner for CS-D software, the “Communication” screen will display (Figure 4). 

 

Figure 4: Communication screen 

• Select the correct COM port from “Port” dropdown list control (Figure 5). When a USB to RS232 

adaptor is used, you can go to Device Manager of your computer to find the correct port. 

 

Information 

About - Display ProTuner software information 
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Figure 5: connecting drive 

• Click “Connect” button and wait a few seconds. If the drive has been successfully connected, the 

“Parameters” screen (Figure 7) will be automatically displayed with all the parameter values uploaded 

from the connected drive. Otherwise, the following error message will be displayed (Figure 6). 

 

Figure 6: Communication error message 

5. Manage Drive Parameters 

Settings and configurations of the connected CS-D closed loop stepper drive are all stored in parameters. They 

can be read, changed, and saved through the ProTuner CS-D software. 

5.1 Read Parameters 

After the CS-D closed loop stepper drive is successfully connected to computer, its current settings will be 

automatically uploaded and displayed (Figure 7). The Parameters window can also be opened any time by 

clicking the “Parameters” icon on the left toolbar or Configuration->Parameters menu item. 
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Figure 7: Parameters 

Filter Displayed Parameters 

On the Parameters window, you can use the top left dropdown list control to filter the displayed parameters 

(Figure 8). 

 

Figure 8: parameter type 

5.2 Edit Parameters 

To edit a parameter value, double click the “Value” field for that parameter. You can then change its value. 

Make sure the input value is an integer in the range defined in the “Range” field. See Figure 9. 
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Figure 9: edit parameter value 

When trying to make parameter value changes, please note: 

• Some parameters are read-only, and take no effect whatever you type in.  

• Some parameters are only effective after the related DIP switches on the CS-D closed loop stepper 

drive are set properly, such as parameters “Microstep Resolution”. Check the full parameter 

description in Section 5.3. 

• Some parameters are only effective after other parameters are set to certain values. Check Section 5.3. 

5.3 Parameter Description 
 

All parameters for the CS-D series closed loop stepper drives are described in this section. 

5.3.1 Microstep (PR 1) 
 
This parameter is used to set micro step resolution. To make this parameter effective,  

• DIP switches 1-4 (DP1-4) of the CS-D drive must be all set to “ON” positions. 

• Its value must be increased by 200 and in the range of 200 – 51,200. 

5.3.2 Peak Current (PR 2) 

This parameter is used to set the peak current that the CS-D drive can output. 

5.3.3 Closed Loop Holding Current Percentage 

This parameter is a percentage value of the peak current in PR 2. It is used for both holding and idle current in 

closed loop control mode (PR 7 value “2”). Increase this parameter value can improve response time and better 

Double click the cell in Value 
column to change the value.  
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torque, but may result in higher heating. For Leadshine motors, it is suggested keep the default value unless 

you really make your own configurations. 

5.3.4 Encoder Resolution (PR 4) 

This parameter value must be set to 4 times of the encoder lines. For example, for a 1000-line encoder this 

parameter value must be set to 4000. 

5.3.5 Allowed Max Position Following Error Pulses (PR 5) 

This parameter is used to set the allowed maximum pulse number of position errors. 

5.3.6 "ALM" or “PEND” Output Type on the Drive (PR 6) 

This parameter is used to configure the type of the configurable digital output signal, which is marked as 

“ALM” on CS-D403 & CS-D508, and “PEND” of CS-D808 & CS-D1008. 

• CS-D403 and CS-D508 

The configurable digital output which is marked as “ALM”. 

o Set this PR 6 value to “0” (default) to configure this output as “ALM” - fault output - signal. 

o Set this PR 6 value to “1” to configure this output as “In Position” - in targeted position - 

output signal. 

o Set this PR 6 value to “2” to configure this output as “Brake” - brake control output - signal. 

• CS-D808 and CS-D1008 

The configurable digital output which is marked as “PEND”. 

o Set this PR 6 value to “0” to configure this output as “In Position” - in targeted position - 

output signal.  

o Set this PR 6value to “1” to configure this output as “Brake” - brake control output signal. 

5.3.7 Control Mode (PR 7) 

This parameter is used to set the control model that the CS-D will operate. Set its value to “0” for open loop 

control; set it to “2” for closed loop control (default). Value “1” is reserved and has no effect. 

5.3.8 Open Loop Output Current Percentage (PR 8) 

This parameter is used to set the output and idle current in a percentage value of the peak current value (PR 2), 

when the CS-D drive operates in open loop control mode. It is only effective when parameter PR 7 is set to “0” 

for open loop control. 

5.3.9 Control Type (PR 9) 

This parameter is only available for CS-D808 and CS-D1008 drives. It is used to set the drive control type. Set 
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its value to “0” (default) for pulse & direction (also called step & direction) control; set its value to “1” for 

CW/CCW control. 

5.3.10 Pulse Effective Edge (PR 10) 

This parameter is only available for CS-D808 and CS-D1008. It is used to determine when a pulse will be 

recognized. Set its value to “0” for rising edge (default); set its value to 1 for falling edge. 

5.3.11 Max Time to Close Brake (PR 11) 

This parameter is used to set the max time for closing the brake. It is only effective when PR 6 is set for brake 

control. Usually don’t change the default value unless you really want. 

5.3.12 Delay of Releasing Brake (PR 12) 

This parameter is used to set the delay time before brake releasing. It is only effective when PR 6 is set for 

brake control. Usually keep the default value of this parameter unless you really want. 

5.3.13 Delay of Closing Brake  (PR 13) 

This parameter is used to set the delay time before starting to close the brake. It is only effective when PR 6 is 

set for brake control. Usually keep the default value of this parameter unless you really want. 

5.3.14 "ENA" Input Signal Level Setting (PR 14) 

This parameter is used to set the “ENA” signal voltage level of the CS-D drive. Set its value to “0” for high 

level (default); set its value to “1” for low level. 

5.3.15 "ALM" Output Signal Impedance State  (PR 15) 

This parameter is used to set the “ALM” signal impedance level of the CS-D drive. Set its value to “0” for high 

level (default); set its value to “1” for low level. 

5.3.16 “PEND” Output Signal Impedance State (PR 16) 

This parameter is only available for CS-D808 and CS-D1008. It is used to set the “PEND” signal impedance 

level of the CS-D drive. Set its value to “0” for high level (default); set its value to “1” for low level. 

5.3.17 Distance to Send "In Position" Output Signal (PR 17) 

This parameter is used to set the distance (in number of pulses) to send out the In-Position signal. It is only 

effective when PR 6 is set for “In Position” output. 

5.3.18 Allow Clearance of Position Following Error (PR 18) 

This parameter is used to set whether or not clearing position following error is allowed by sending an enable 

signal via the “ENA” connection on the CS-D drive. Set its value to “1” (default) for yes; set it to “0” for no. 
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5.3.19 Current Loop Bandwidth (PR 19) 

This parameter is used to set the current loop bandwidth of the CS-D drive. It is for advanced users only. 

Usually keep the default value for powering Leadshine motors, or 3rd party stepper motors with normal 

inductance. 

If the 3rd party stepper motor has extremely low or high inductance, and high noise or/and vibration are found 

after power-on. You can try to tune this parameter along with PR 20. Usually choose a value of 800-2000. 

Follow the following steps to tune this parameter: 

• Step 1: compare the read-only parameter “Inductance” value (PR 27) on the Parameters screen with 

the inductance value found on the stepper motor datasheet (ensure the accuracy of the datasheet), 

when auto-tuning feature of the drive is turned on. 

• Step 2:  If those two values in Step 1 are significant different (50% or more), tune this parameter value 

along with parameter PR 20.  

• Step 3: If unable to find a preferred PR 19 & 20 value combination, turn off the “Auto-Tuning” feature 

via DIP switch 6 of the CS-D drive. 

5.3.20 Current Loop Ki (PR 20) 

This parameter is used for tuning current loop integral gain. It is tuned along with PR 20 (See 5.3.19). Usually 

keep the default value for Leadshine motors and 3rd party motors with normal inductance.  

5.3.21 Position Loop Kp (PR 21) 

This parameter is used for tuning position loop proportional gain. Usually keep the default value for Leadshine 

stepper motors, unless really needed to do so.  

• Increase this value will reduce position following error, but could result in motor vibration.  

• Decrease the value if the motor vibrates. 

5.3.22 Velocity Loop Kp (PR 22) 

This parameter is used for tuning velocity loop integral gain. Usually keep the default value for Leadshine 

stepper motors, unless really needed to do so.  

• Increase the value can increase velocity stiffness. 

• Reduce this value when the motor vibrates at low speed.  

5.3.23 Velocity Loop Ki (PR 23) 

This parameter is used for tuning Velocity loop proportional gain. Usually keep the default value for Leadshine 

stepper motors unless really needed to do so. This parameter is usually tuned along with PR 22. Set it to 0 if 
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the motor shakes during settling. 

5.3.24 Motor Shaft Locking Time (PR 24) 

This parameter is used to set the motor shaft locking time. Usually keep the default value, unless you really 

want to make a change. 

5.3.25 Internal Filtering Time (PR 25) 

This parameter is used to configure the time for internal command filtering. In some applications, change this 

value could improve overall system performance. 

Note: for multi-axis systems with interpolation, this value must be set to the same for all axes. 

5.3.26 Soft-Starting Time (PR 26) 

This parameter is used to configure the internal smoothing time for the CS-D drive initial current ramp-up 

when the drive is turned on. Increase this value if there is a motor overshooting like “JUMP” at powered-on. 

5.3.27 Motor Inductance (PR 27) 

This parameter is read-only, when the Auto-Tuning on the drive is turned on. It is for reference only. 

5.3.28 Auto-Tuning at Power-on (PR 28) 

This parameter is used to set if the drive auto-tuning is turned on at power-on. It is read-only parameter for 

informational only. Its value is actually determined by dip switch SW6 of the CS-D drive. 

5.3.29 Velocity Switching Point: Open Loop to Closed Loop  (PR 29) 

This parameter is used to set the velocity switching point from closed loop control to open loop control. 

Usually keep the default value. Only change it when it causes motor vibration at this mode switching velocity 

point. 

5.3.30 Velocity Switching Point: Closed Loop to Open Loop  (PR 30) 

This parameter is used to set the velocity switching point from closed loop control to open loop control. 

Usually keep the default value. Only change it when it causes motor vibration at this mode switching velocity 

point. 

5.3.31 Motion Type (PR 31) 

This parameter is used to set motion type based on your application. It currently contains the following motion 

types: 

• “Normal”: this is the default motion type for normal applications. 
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•  “Fast response”: this motion type is suitable for applications with high acceleration applications. For 

example, select this type may improve system performance for application such as many bonding 

type machines frequently seen in electronics. 

• “Low speed circular interpolation”: this motion type is suitable for some applications requiring 

circular interpolation at extra low speed (< 60 RPM). 

Usually keep the default setting, unless this motion type can’t meet your requirement and your application falls 

into one of the other listed motion types. 

5.3.32 Self-Test at Power-on (PR 32) 

This parameter is used to indicate if auto-test set homing will be performed at power-on. When its value set to 

“1”, the motor will rotate half a revolution in each direction (clockwise and counterclockwise) at power-on. 

When set to “0”, there is no effect for this parameter. 

5.4 Motion Test 

Open the Motion Test window (Figure 10) by clicking “Motion Test” icon on the toolbar or 

Configuration->Motion Test menu item for configuration performance test. This Motion Test window of 

ProTuner software can be used to: 

• Perform motion performance test for current drive parameter setting. Read section 5.4.2 

• Monitor motion performance when the CS-D drive takes control signals from a connected motion 

controller/PLC/pulse generator… 

5.4.1 Motion Test Window 

The Motion Test Window includes 3 areas marked in Figure 10, “Scope”, “Motion Parameters”, and “Motion 

Testing”. 
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Figure 10: Motion Test window 

• The top “Scope” (Figure 11) area of the Motion Test window contains a scope used to display colored 

curves based on what have been chosen on Channel 1 and Channel 2 dropdown lists during the test. 

 

Red “Position Error” curve 
displayed here for Channel 1 
selection 

Blue “Velocity Feedback” displayed 
here for Channel 2 selection 
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Figure 11: Scope portion of Motion Test window 

Available options for Channel 1 add 2 dropdown list controls include “Position Error”, “Velocity 

Feedback”, “Position Feedback”, “Velocity Targeted”, “Positon Targeted”, “Synthetic Current”, “Bus 

Voltage”, “A Phase Current”, and “B Phase Current”. See Figure 12. 

 

Figure 12 curve type options 

• The bottom left “Motion Parameters” area (Figure 13) of the Motion Test window displays editable 

text fields and selectable radio buttons for the motion test. 

 

Figure 13: motion test parameters 

Find those parameter description in the following table 

Item Description Range 

Speed (rpm) Targeted velocity of the motion test. 1 - 5000 rpm 

Acceleration 
(r/s/s) 

Acceleration of the motion test. 1 - 3000 r/s^2 

Distance (r) 
Movement distance in number of 
revolutions, for the motion test. 

1 - 655 revolutions 

Interval (ms) Interval between two movements. 1 - 32767 ms 

Repeat # Repeat times of the motion test 1 - 65535 
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Sampling 
Interval 

Interval between two data samplings 1 - 50 

Rotation Motor initial rotation direction 
Clockwise, or 
Counterclockwise 

Direction Type of rotation directions for motion test 
Unidirectional, or Back and 
forth 

 

• The bottom right “Motion Testing” area of motion test window (Figure 14) is used to choose what 

motion test type to perform. Select “Performance Tuning” to tune the CS-D drive; choose “Scope” for 

motion performance monitoring when the CS-D drive takes control commands from a connected 

controller. 

 

Figure 14: Motion test type selection 

5.4.2 Tuning Performance Testing 
 

To tune and test the performance for the current drive settings 

• Connect the CS-D drive to ProTuner software. 

• After parameter values uploaded to the software, you can choose to make value changes or not as 

needed. 

• Switch to the Motion Test window by clicking “Motion Test” icon on the left toolbar. 

• Keep the default selection of “Performance Tuning” option (Figure 14).  

• Choose what to display on the scope for Channel 1 and 2 (Figure 12). 

• Fill in test motion parameters (Figure 13). 

• Click thee “Start” button to start motor rotation. 

• Test the motion performance by checking: 

o The curves displayed on the scope (Figure 12), 

o The motor and drive noise, vibration, heating, etc. 



                                CS Series Closed-loop Stepper Drives Software Manual V3.1 

 

Page | 16  
 

5.4.3  Motion Performance Monitoring 

Besides used for motion performance testing for the current CS-D drive setting when ProTuner itself is used to 

control commands, the Motion Test window can also be used for motion performance monitoring when the 

drive is controlled by an external pulse generator (controller, PLC, etc.). For example, a user can use the 

proTuner software to monitor the motion performance of certain axis in a machine which is powered by a CS-

D drive, but its motion commands are sent from the machine’s motion controller.  

Follow the following steps: 

• Connect ProTuner software to the CS-D drive which is commanded by an external controller. 

• Switch to the Motion Test window by clicking the “Motion Test” icon on the left toolbar. 

• Select “Scope” option for “Motion Test Type” on the bottom right side. See Figure 15. 

• Choose what to display on the scope for Channel 1 and 2 (Figure 12). 

• Keep the default value or enter a new value for the “Sampling Interval” time field. 

• Click “Start” button to start monitoring. 

• Start motion from the pulse generator connected to the CS-D drive. 

• Monitor the motion performance by checking: 

o The curves displayed on the scope (Figure 12), 

o The motor and drive noise, vibration, heating, etc. 

 

Figure 15: motion performance monitoring 



                                CS Series Closed-loop Stepper Drives Software Manual V3.1 

 

Page | 17  
 

6. Write to Drive  (Download to Drive) 

After parameters tuned & optimized and motion performance tested, you must download their changes to the 

drive. Otherwise, those changes will be lost next time when the drive is re-powered. 

Following the following steps to write parameters to the drive. 

• Click the “Write to Drive” icon on the left toolbar, or Configuration->Parameters menu item. A 

confirmation will be popped up (Figure 16) 

 

Figure 16: Write to drive confirmation message 

• Click “Yes” to continue downloading parameter values to the CS-D drive. 

• After parameters are successfully written to the drive, a success message (Figure 17) will be popped 

up. Now, all the changes are permanent and new settings for the CS-D drive will take effect next time 

when the drive is re-powered. 

 

Figure 17: Write to drive success message 

7. Resetting Drive 

To reset the current drive configurations back to factory settings, follow the following steps. 

• Click Drive->Reset menu item. The confirmation message will be popped up (Figure 18).  



                                CS Series Closed-loop Stepper Drives Software Manual V3.1 

 

Page | 18  
 

 

Figure 18: resetting confirmation message 

• Click the “Yes” button to continue resetting process, or click “No” button to cancel. After resetting 

finished, the following informational message (Figure 19) will be displayed. Factory settings will take 

effect next time when the drive is powered next time. 

 

Figure 19: reset success message 

8.  Manage Configuration File 

After the drive performance is tuned and parameter values optimized, its settings can be saved to a 

configuration file in .lsr format. You can also open an existing .lsr configuration file and load the settings to the 

ProTuner CS-D software. 

7.1 Open a Configuration File 

Follow the following steps to load settings from an .lsr configuration file 

• Click Project->Open menu item. The File Open window will be displayed (Figure 20). 
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Figure 20: open an .lsr configuration file window 

• Find and select the .lsr configuration fil click “OK” button. 

• After the configuration file is open, a message (Figure 21) will be displayed; all the parameter values 

stored in that configuration file will be loaded and displayed in the Parameters window. You can now 

tune those parameters or directly download them to the connected CS-D closed loop stepper drives. 

 

Figure 21: Open file confirmation 

 

After a configuration file is opened, to get back to its original settings you will need to repower the CS-D 

closed loop stepper drive. 

 

!
Notice



                                CS Series Closed-loop Stepper Drives Software Manual V3.1 

 

Page | 20  
 

7.2 Save a Configuration File 

Follow the following steps to save the current parameters into an .lsr configuration file 

• Click Project-> Save As menu item. The following screen on Figure 22 will be displayed: 

 
Figure 22: save configuration file 

• Choose the location and file name and click the Save button. 

9. Manage Drive Error History 

You can use the ProTuner for CS-D software to track error history previously happened to the connected CS-D 

closed loop stepper drives. Follow the following steps for that: 

• Click Error Track icon on the left toolbase or  click Drve->Error Track menu item, the Error Track 

window (Figure 23) will be displayed.  
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Figure 23: Error Track window 

• Click the “Previous Error(s)” tab to see error(s)previously happened in the past. 

10. Help Menu 

10.1 Software Manual  

When clicking Help-> Software menu item, the software manual will be opened. 

10.2 Product Information 

To display the product information of the connected CS-D closed loop stepper drive, click Help->Production 

Information menu item. The message window in Figure 24 will be displayed. 

 

Figure 24: Product information 
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10.3 A bout 

To display the software information, click Help->About menu item. The message window in Figure 25 will be 

displayed. 

 

 

Figure 25: Software information 
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Appendix - Parameters for CS-D closed loop stepper drives 

1) CS-D403 and CS-D508 Closed Loop Stepper Drive Parameters 

Parameter 
# Name 

Default 
Value Range Unit Remark 

PR 1 
Microstep 
resolution 

1600 200-51200 
Pulse / 

revolution 

To change this value, DIP switches 
SW1-SW4 on the drive must be all set 
to "ON" positions. Its value must be 
increased by 200 such as 200, 400, 
800, 1000, … 

PR 2 Peak current  

25 
(CS-D403) 

10-80 0.1A Drive's max output current. 
60 

(CS-D508) 

PR 3 
Closed loop 
holding current 
percentage 

40 
(CS-D403) 

10-100 % 

Also used by idle current in closed 
loop control mode. 1) Percentage of 
peak current (PR 2); 2) Only available 
when PR 7 value set to 2. 

50 
(CS-D508) 

PR 4 
Encoder 
resolution 

4000 200-20000 
Count / 

revolution 

This value must be 4 times of encoder 
lines. For example, this value muse be 
set to 4000 for a motor with a 1000-
line encoder. 

PR 5 

Allowed max 
position 
following error 
pulses 

4000 0-65535 Pulse Threshold for position following error. 

PR 6 
"ALM" output 
type on drive 

1 1-3 - 
Setting for the “ALM” output on the 
drive: 1 – Alarm; 2 - In position; 3 - 
Brake.  

PR 7 Control Mode 2 0-2 - 
Control mode setting: 0 - Open loop, 2 
- Closed loop; 1 – Reserved 

PR 8 
Open loop output 
current 
percentage 

50 0-100 % 

Output current in open loop control 
mode which is a pct. value of peak 
current (PR 2). Only effective when 
PR 7 set to value 0 

PR 11 
Max time to 
close brake 

1000 100-10000 ms 
Only available when PR 6 set to 3. 
Usually keep this default value. 

PR 12 
Delay of  
releasing brake 

250 0-1500 ms 
Only available when PR 6 set to 3. 
Usually keep this default value.  

PR 13 
Delay of closing 
brake 

250 0-1500 ms 
Only available when PR 6 set to 3. 
Usually keep this default value.  

PR 14 
ENA input signal 
level setting 

1 0-1 - 
ENA effective voltage level setting: 0 - 
high level, 1- low level 
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PR 15 
"ALM" output 
signal impedance 
state 

1 0-1 - 
Setting for “ALM” output impedance 
level: 0 - high impedance; 1 - low 
impedance 

PR 17 
Distance to send 
"In Position" 
output signal 

4 0-100 pulse 

Distance to target position in number 
of pulses to send "In Position" output 
signal. Only available when PR 6 set to 
“In Position” 

PR 18 
Allow clearance 
of position 
following error 

1 0-1 - 

Setting for allowing position error 
clearing via “ENA” signal on the drive 
without re-powering of the drive: 0 - 
No, 1 - Yes. 

PR 19 
Current loop 
bandwidth 

1500 0-3000 Hz 
Usually keep the default value. 

Recommended for 800-2000. 

PR 20 Current loop Ki 300 0-1000 - 
Current loop integral gain. Usually 
keep the default value. 

PR 21 Position loop Kp 25 0-100 - 

Position loop proportional gain. 1) 
Increase this value can reduce position 
following error. 2) Decrease the value 
if the motor vibrates. 3) Usually keep 
the default value. 

PR 22 Velocity loop Kp 25 0-100 - 

Velocity loop proportional gain. 1) 
Increase the value can increase 
stiffness. 2) Reduce this value when 
the motor vibrates at low speed. 3) 
Usually keep the default value. 

PR 23 Velocity loop Ki 3 0-100  
Velocity loop integral gain. Usually 
keep the default value. Set it to 0 if the 
motor shakes during settling. 

PR 24 
Motor shaft 
locking time 

200 0-1500 ms 
Usually keep the default value. Reduce 
this value if you want to shorten the 
time of locking shaft. 

PR 25 
Internal filtering 
time 

15 0-512 ms 

Internal smoothing time for control 
commands. 
Note: for multi-axis systems with 
interpolation requirements, this value 
must be set to the same for all axes. 

PR 26 Soft-starting time 1 1-30 0.1s 

Internal smoothing time for starting 
current. Increase this value if there is a 
motor overshooting (“Jump”) at 
power-on. 

PR 27 Motor inductance - 0-10000 - 
Read-only parameter and for reference 
only, when the drive Auto-Tuning 
feature on the drive is turned on. 

PR 28 
Auto-tuning at 
power-on 

1 0-1 - 
Read-only parameter. Its value is 
determined by if the “auto-tuning” has 
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been turned on from DIP 6 of the 
drive: 0 - No, 1 - Yes. 

PR 29 

Velocity 
switching point: 
open loop to 
closed loop 
control 

18 0-100 0.1r/s 

Usually keep the default value. Only 
change it when it causes motor 
vibration at this mode switching 
velocity point. 

PR 30 

Velocity 
switching point: 
closed loop to 
open loop control 

12 0-200 0.1r/s 

Usually keep the default value. Only 
change it when it causes motor 
vibration at this mode switching 
velocity point. 

PR 31 Motion type 0 0-10 - 

Setting for motion type: 
0 - Normal, 1- Fast response, 2- Low 
speed circular interpolation, reserved 
for the rest. Usually keep the default 
value. 

PR 32 
Self-test 
indicator at 
power-on 

0 0-1 - 

0 - No, 1 - Yes. When turned on (value 
“1”), the motor will rotate half a turn 
on each direction at power-on. 

 

Note: All parameter values for CS-D403 and CS-D508 must be integers.  
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2) CS-D808 and CS-D1008 Closed Loop Stepper Drive Parameters 

Parameter 
# Name 

Default 
Value Range Unit Remark 

PR 1 
Microstep 
resolution 

1600 200-51200 
Pulse / 

revolution 

To change this value, DIP switches 
SW1-SW4 on the drive must be all set 
to "ON" positions. Its value must be 
increased by 200 such as 200, 400, 
800, 1000, … 

PR 2 Peak current  80 10-80 0.1A Drive's max output current. 

PR3 
Closed loop 
holding current 
percentage 

50 10-100 % 

Also used by idle current in closed 
loop control mode. 1) Percentage of 
peak current (PR 2); 2) Only available 
when PR 7 value set to 2. 

PR 4 
Encoder 
resolution 

4000 200-20000 
Count / 

revolution 

This value must be 4 times of encoder 
lines. For example, this value muse be 
set to 4000 for a motor with a 1000-
line encoder. 

PR 5 

Allowed max 
position 
following error 
pulses 

4000 0-65535 Pulse Threshold for position following error. 

PR 6 
"PEND " output 
type on drive 

0 0-1 - 
Setting for the “PEND” output on the 
drive: 0 – In Position; 1 - Brake.  

PR 7 Control Mode 2 0-2 - 
Control mode setting: 0 - Open loop, 2 
- Closed loop; 1 – Reserved 

PR 8 
Open loop output 
current 
percentage 

50 0-100 % 

Output current in open loop control 
mode which is a pct. value of peak 
current (PR 2). Only effective when 
PR 7 set to value 0 

PR 9 Control type 0 0-1 - 0 - PUL / Dir, 1 - CW/CCW 

PR 10 
Pulse effective 
edge 

0 0-1 - 0 - Rising edge, 1 - Falling edge 

PR 11 
Max time to 
close brake 

1000 100-10000 ms 
Only available when PR 6 set to 3. 
Usually keep this default value. 

PR 12 
Delay of  
releasing brake 

250 0-1500 ms 
Only available when PR 6 set to 3. 
Usually keep this default value.  

PR 13 
Delay of closing 
brake 

250 0-1500 ms 
Only available when PR 6 set to 3. 
Usually keep this default value.  

PR 14 
ENA input signal 
level setting 

1 0-1 - 
ENA effective voltage level setting: 0 - 
high level, 1- low level 
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PR 15 
"ALM" output 
signal impedance 
state 

1 0-1 - 
Setting for “ALM” output impedance 
level: 0 - high impedance; 1 - low 
impedance 

PR 16 
"PEND" output 
signal impedance 
setting 

1 0-1 - 
Impedance setting for the “PEND” 
output on the drive: 0 - high 
impedance; 1 - low impedance 

PR 17 
Distance to send 
"In Position" 
output signal 

8 0-100 pulse 

Distance to target position in number 
of pulses to send "In Position" output 
signal. Only available when PR 6 set to 
“In Position” 

PR 18 
Allow clearance 
of position 
following error 

1 0-1 - 

Setting for allowing position error 
clearing via “ENA” signal on the drive 
without re-powering of the drive: 0 - 
No, 1 - Yes. 

PR 19 
Current loop 
bandwidth 

1200 0-3000 Hz 
Usually keep the default value. 

Recommended for 800-2000. 

PR 20 Current loop Ki 200 0-1000 - 
Current loop integral gain. Usually 
keep the default value. 

PR 21 Position loop Kp 45 0-100 - 

Position loop proportional gain. 1) 
Increase this value can reduce position 
following error. 2) Decrease the value 
if the motor vibrates. 3) Usually keep 
the default value. 

PR 22 Velocity loop Kp 15 0-100 - 

Velocity loop proportional gain. 1) 
Increase the value can increase 
stiffness. 2) Reduce this value when 
the motor vibrates at low speed. 3) 
Usually keep the default value. 

PR 23 Velocity loop Ki 0 0-100  
Velocity loop integral gain. Usually 
keep the default value. Set it to 0 if the 
motor shakes during settling. 

PR 24 
Motor shaft 
locking time 

200 0-1500 ms 
Usually keep the default value. Reduce 
this value if you want to shorten the 
time of locking shaft. 

PR 25 
Internal filtering 
time 

15 0-512 ms 

Internal smoothing time for control 
commands. 
Note: for multi-axis systems with 
interpolation requirements, this value 
must be set to the same for all axes. 

PR 26 Soft-starting time 8 1-30 0.1s 

Internal smoothing time for starting 
current. Increase this value if there is a 
motor overshooting (“Jump”) at 
power-on. 
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PR 27 Motor inductance - 0-10000 - 
Read-only parameter and for reference 
only, when the drive Auto-Tuning 
feature on the drive is turned on. 

PR 28 
Auto-tuning at 
power-on 

1 0-1 - 

Read-only parameter. Its value is 
determined by if the “auto-tuning” has 
been turned on from DIP 6 of the 
drive: 0 - No, 1 - Yes. 

PR 29 

Velocity 
switching point: 
open loop to 
closed loop 
control 

18 0-100 0.1r/s 

Usually keep the default value. Only 
change it when it causes motor 
vibration at this mode switching 
velocity point. 

PR 30 

Velocity 
switching point: 
closed loop to 
open loop control 

12 0-200 0.1r/s 

Usually keep the default value. Only 
change it when it causes motor 
vibration at this mode switching 
velocity point. 

PR 31 Motion type 0 0-10 - 

Setting for motion type: 
0 - Normal, 1- Fast response, 2- Low 
speed circular interpolation, reserved 
for the rest. Usually keep the default 
value. 

PR 32 
Self-test 
indicator at 
power-on 

0 0-1 - 

0 - No, 1 - Yes. When turned on (value 
“1”), the motor will rotate half a turn 
on each direction at power-on. 

 

Note: All parameter values for CS-D808 and CS-D1008 must be integers. 
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